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01. GENERAL DESCRIPTION
The Actron VRF Select software is designed to streamline the process of VRF system selection. Users can effortlessly determine the 
ideal VRF system for their needs by inputting basic system details into the software. Moreover, users have the flexibility to import 
a background image, such as a system layout or map, which enhances the system selection process by aiding in the selection of 
indoor and outdoor units.

The Actron VRF Select software offers three distinct design modes, each serving a specific purpose:

1. Drag and Drop Mode
This selection view simplifies the VRF system selection process through a user-friendly drag-and-drop menu. You can easily 
position indoor units, branch joints, and outdoor units on the Actron VRF Select display page according to your specific 
requirements. 

The Drag and Drop View offers a convenient and swift selection process within the software.

2. AutoCAD Mode
The following mode for system selection is the AutoCAD view. This mode provides a selection experience within the built-in 
AutoCAD interface of Actron VRF Select. Users can also import DWG, JPG, or BMP drawings, enabling them to make selections 
directly on the AutoCAD floor plan or layout drawing. This aspect of the software is especially beneficial for users accustomed to 
working with AutoCAD floor plans. The AutoCAD mode significantly streamlines the selection process in such cases.

3. Table Mode
The Table mode provides a straightforward approach to selecting a VRF system and adding Indoor and Outdoor Units to it. In this 
mode, you can swiftly compile a list of the necessary equipment for a specific selection. It’s important to note that, to position the 
units according to their respective locations and pipe lengths, you’ll need to switch to one of the aforementioned modes in either 
the Drag and Drop View or AutoCAD View.
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01.01. Starting Up
This section is dedicated to understanding the fundamentals of commencing a new project within the Actron VRF Select 
software. Before delving into the software, you’ll encounter several initial options. In this segment, we will systematically explore 
each of these options.

01.01.01. New
The New Tab in Actron VRF Select provides the functionality to initiate a fresh project within the software. From this point, 
you can choose among three distinct views available in Actron VRF Select. If you’re commencing an entirely new project, the 
New Tab is the ideal starting point.

Show on start up

No. Button Function

1 New This tab is used to enter a new selection for the Actron VRF Select.

2 Different Views
There are two types of views inside the Actron VRF Select software: 
Table View and Drag and Drop View

3 Show on Start up

 The software will not show this page and directly open the selection interface 
selected at the time of previous startup.

 The software will show this page next time and ask you to choose the type of 
selection interface.

01.01.02. Open
The Open Tab within Actron VRF Select offers the opportunity to access previously saved Actron VRF Select files. If you’ve 
utilised Actron VRF Select in the past, this feature enables you to open projects that were saved either on OneDrive or your 
local drive, allowing you to edit and revisit these prior projects.

 
 
 
 
 
 

Show on start up

No. Button Function

1 Open
This button gives the option to open the previously saved Actron VRF Select files 
available on the computer.

2 Recent Files This list will show the recently used Actron VRF Select selection files.

3 OneDrive
This will show the list of Actron VRF Select project files saved on the one drive 
(Cloud Storage) of the computer.
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01.01.03. Import
The Template Tab within Actron VRF Select provides the choice to import a pre-existing template file for analysis. 
Alternatively, you can click on Open Load Template to create a new file and input the template details according to your 
specific requirements.

Show on start up

No. Button Function

1 Template
Click on this button to import a template file into the software (it can be both 
Load Template as well as Units Template).

2 Open Load Template
Click on this button to export the Load Template file of Actron VRF Select 
software.

3 Open Units Template
Click on this button to export Units Template file of the Actron VRF Select 
software.

01.02. Different Views
Within Actron VRF Select, there are three distinct views available: Drag and Drop View, AutoCAD View, and Table View. On the 
selection interface, users have the flexibility to choose their preferred view for making selections.

A. Drag and Drop View

In this view, we can drag and drop the various Indoor Units and branch joints to make the selection. 

No. Item Description

1 Project View Project View Tab

2 To Layout list view To Layout list view Tab

3 Properties View Properties View Tab

4 Output View Output View Tab

5 Status Tab Status View Tab

6 Working Interface The current project is shown here

7 Basic Functions Basic functions like open and save a project file

8 Tabs We can switch the tabs from here (Home/Display/Export/Tools/Help)

9 Buttons This interface shows the buttons which are present inside a tab
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B. AutoCAD View

In this view, the software will launch the AutoCAD selection interface, enabling users to directly choose the refrigerant system on 
the AutoCAD view within Actron VRF Select. This feature is especially useful when you have an existing AutoCAD drawing or floor 
plan for the selection area.

No. Item Description

1 Project View Project View Tab

2 To Layout list view To Layout list view Tab

3 Properties View Properties View Tab

4 Output View Output View Tab

5 Status Tab Status View Tab

6 Working Interface The current project is shown here.

7 Basic Functions Basic functions like open and save a project file

8 Tabs We can switch the tabs from here (Home/Display/Export/Tools/Help).

9 Buttons This interface shows the buttons which are present inside a tab.

C. Table View

In this view, the software will open the Table mode selection interface and we can put the list of the equipments that are required 
to be used in a particular system selection.

No. Item Description

1 Working Interface The current project is shown here.

2 Properties View Properties View Tab

3 Output View Output View Tab

4 Status Tab Status View Tab

5 Basic Functions Basic functions like open and save a project file.

6 Tabs We can switch the tabs from here (Home/Display/Export/Tools/Help).

7 Buttons This interface shows the buttons which are present inside a tab.
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01.03. Basic Settings
Before commencing a new selection within the Actron VRF Select system, there are a few fundamental configurations that should 
be addressed. These settings are essential for improving the system selection process in the software. The three key settings 
used within the software are as follows:

01.03.01. Project Properties

Clicking the Project Properties button will trigger the appearance of the following dialog box. The Project 
Properties tab can be subdivided into four distinct sections. A concise overview of the functions of each of these 
four parts is provided below:

A brief introduction about the five tabs are as below:  

No. Button Description

1 Project Info
Here, we can set the basic information about the project like project name, 
address, location, client name etc. On the basis of the location the default design 
conditions would be automatically loaded in the software.

2 Project Design Condition
Here, we can set the project design conditions according to the location,
Euro vent , AHRI or Manual as well.

3 Unit Priority Here, we can select the default values for the selection.

4 Terms Condition
In the terms and condition section, we can write some terms and conditions to be 
included in the final report.

5 Memorandum Reserved Function

01.03.02. Unit Set

In the units set section, we can select the default units to be used in the software.

01.03.03. Piping Specifications

In this section, we can select the piping size which are available / not available in a given market; the software, while selecting 
the pipe size will select pipes according to this list only.

Display Description

Piping Size not available in market

Piping Size available in market
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02. FUNCTIONS OF VARIOUS TABS 
In this segment, we will delve into the crucial functions of the different tabs within the Actron VRF Select software’s selection 
interface. Each tab’s functions will be thoroughly described in the following section, one at a time.

02.01. Home Tab
The Home tab holds the utmost significance as the initial tab in the Actron VRF Select system. It encompasses options for system 
initiation, calculations, and view adjustments. The Home tab is further organised into six distinct sections, each of which will be 
detailed below:

02.01.01. Systems Tab
This is the basic tab to start building a system.

No. Button Function

1 This button is used to add a new system.

2 This button is used to add a new Indoor Unit to the system.

3
 

This button is used to add a new AHU to the system.

4
This button is used to edit the current system including Indoor Units and Outdoor 
Unit selections in Drag and Drop or Table mode.

5
This button is used to delete the current system or Indoor Units or Outdoor Units 
during drag and Drop or Table selection.

6 This button is used to undo a previously done action.

7
This button is the opposite of the Undo button and is used to redo a previously 
undone operation.

02.01.02. Project Tab
This tab provides a list of settings which are required to be performed before starting the selection of the system. The 
following are the two options that are available in this tab.

Project Properties 

On clicking the Project Properties the following dialog box would appear. The Project Properties tab can be further 
divided into four parts. Please refer to subsection 01.03.01 Project Properties for a brief introduction about the 
functions of its all four parts.

Unit Set

In the units set section, we can select the default units to be used in the software. Please refer to subsection 01.03.02. 
Unit Set.

02.01.03. Centralised Group Tab
This tab is used while selecting the Centralized controller, BMS gateways, etc. in the Controls view only. To use this command, 
you must be inside the Controls View of the Actron VRF Select software only.

No. Button Function

1
 

This button is used to add a new centralised controller group.

2 This button is used to edit an already added centralized controller group.

02.01.04. Calculate/Operation Mode Tab
This tab needs to be used after completing the selection for Indoor Units and Outdoor Unit for a system.

Sr. No. Button Function

1
This button is used to perform calculations for the existing system whereas if you 
click on the arrow below you can perform calculations for all the systems in the 
current project.

2 Full Demand Operation

It is default and recommended, capacity correction setting. This setting assumes 
that all the indoor units are calling for full capacity at the same time. Actron VRF 
Select will divide the capacity equally across all the indoor units. Depending on 
the size of the indoor unit. This becomes especially important for designs with 
over 100% connected capacity.

3 Partial Demand Operation
This setting will display the full performance of an indoor unit, without 
considering the connected capacity of the system. This setting assumes that all 
the indoor units are not calling for full capacity at the same time.

4
Partial Cooling/Full Heating 

Operation
This setting will display partial demand for cooling performance and full demand 
for heating performance.

02.01.05. Switch View

From the Switch View tab, we can select the style of viewing the project. There are three options, which are 
discussed below:

1.  Design View 
The design view allows you to select a system and provides an interface for selecting the system. It has two ways of selecting: 
Free Mode and Drag Mode. 
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A. Free Mode/AutoCAD View

The Free Mode corresponds to the AutoCAD view detailed in subsection 01.02. Different Views. This mode allows you to 
carry out your selection within the AutoCAD version of the software, including the capability to import background .dwg 
images. More comprehensive instructions on making selections within the AutoCAD view can be found in subsequent 
sections of this manual.

B. Drag Mode/Drag and Drop View

The drag mode is the Drag and Drop View discussed in subsection 01.02. Different Views. Here you can simply select a system 
by dragging and dropping the required components of a system on the working interface. 

2.  Table View
This view shows the equipment used in the selection in the form of a table. This is synonymous with the Project View in the 
above two views. This is basically used for quick selection. And here we can quickly make the list of equipments.

3.  Controls View
This interface is basically for selecting centralized controllers, BMS gateways etc.
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02.01.06. View
This tab allows you to see the various Menu items inside the Actron VRF Select software and make the software easily usable 
for the end user. On checking the column given in front of a tab; it will be shown, hidden respectively.

Display Description

Hidden

Shown

No. View Name Description

1 Project View This tab shows all the systems/groups in the use in Design/Table view respectively.

2 To Layout list View You can drag and drop the units from this tab to the main interface.

3 Properties View This tab will show the details of the selected object.

4 Output View After you click calculate, this tab will show the calculation results.

5 Status Bar This tab shows the current status of the software.

6 Working Interface The current project is shown here.

Project View

To enable the display of this tab, ensure that the Project View Column is ticked, as illustrated in the 
image below. The Project View tab provides an overview of the number of systems within the current 
project. Additionally, you can use this tab to copy or delete systems. In contrast, the Control View tab 
offers insights into the different centralized controller groups.

Output View

To reveal this tab, ensure that the Output View Column is selected, as demonstrated in the image below. 
The Output View provides an overview of the results stemming from the software’s calculations. Users 
can inspect these calculations to identify any potential selection errors.
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To Layout list View

To display this tab, make sure to select the To Layout List View Column, as depicted in the image 
below. This tab offers a straightforward selection method, allowing users to effortlessly add items to 
their selection by dragging and dropping them from this tab.

Status Bar

The Status Bar Column should be checked as shown in the picture below to make this tab to display. This 
tab shows the current status of the Actron VRF Select software.

NOTE

The file is successfully saved.[3s]

Properties View

To make this tab visible, ensure the Properties View Column is activated, as indicated in the image 
below. This tab is responsible for displaying item details when you left-click on an element in the 
Actron VRF Select software’s working interface.

02.02. Display Tab
Within the Display tab, users have the ability to customize the items visible in the project’s working interface. This tab empowers 
users to access highly specific system details precisely when they need them.

No. Item Description

1 Show Name To hide/show the name of Indoor Unit/Outdoor Unit

2 Show Room To hide/show the name of the room

3 Show Model To hide/show the model name

4 Show Cooling Capacity To hide/show the cooling capacity

5 Show Healing Capacity To hide/show the heating capacity

6 Show Required Cooling Capacity To hide/show the required cooling capacity

7 Show Required Heating Capacity To hide/show the required heating capacity

8 Show Required Cooling Capacity % To hide/show the required cooling capacity%

9 Show Required Heating Capacity % To hide/show the required heating capacity%

10 Show Address To hide/show the address

11 Show All Pipes To hide/show the pipes

12 Show PQE Wire To hide/show the PQE communication wires

13 Show Controllers To hide/show the connected wired/group controllers

14 Show H1H2E To show H1H2E

Display Description

Hidden

Shown



  21  20 ACTRON VRF SELECT Manual
Doc. No. 9590-5028-10  Ver. 1  231112

ACTRON VRF SELECT Manual ECOFLEX MINI VRF R-32 SERIES

ACTRON VRF SELECT Manual
Doc. No. 9590-5028-10  Ver. 1  231112

ACTRON VRF SELECT Manual ECOFLEX MINI VRF R-32 SERIES

02.03. Export Tab
The Export Tab comes into play when the selection of indoor units, outdoor units, and centralized controllers is complete. 
Within this tab, users can export a comprehensive materials list and generate a project report in both Excel and PDF formats, as 
illustrated in the table below.

No. Item Description

1
Exports the list of materials required to complete the project. It provides the list of 
Equipment as well as the list of materials that we need to arrange on the field.

2
This gives a list of the electrical parameters for the VRF outdoor units being used in 
the project.

3
This is used to export a complete detailed list for the Project requirements. We have 
two options; we can export the Report in PDF as well as the Excel format.

4
This button is used to export the piping diagrams and centralized controllers 
diagram in AutoCAD format to a location on the computer.

5 Reserved Button

02.04. Tools Tab
This tab provides some basic tools for performing the selection.

02.04.01. Piping Specifications
In this section, we can select the piping size which are available/not available in a given market ; the software, while selecting 
the pipe size will select pipes according to this list only.

Display Description

Piping Size available in market

Piping Size not available in market

02.04.02. Model Comparison
This function is used to compare the Actron brand indoor and outdoor unit models with other brand models. The user may 
simply upload or download the Templates inside the software using this function.

Password: model2019
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03. AUTOCAD VIEW/FREE MODE MENU BUTTONS
The AutoCAD mode comes equipped with several distinctive buttons, and their functionalities are thoroughly delineated in the 
table below. Each menu button serves specific purposes, and the comprehensive details are provided as follows.

No. Item Description

1 AutoCAD Functions
This shows the various function buttons required while doing a selection in 
the AutoCAD mode of the Actron VRF Select selection software. The details 
about the functions of each button have been discussed below.

2 AutoCAD Drawing View
Osnap: It means the lines in the AutoCAD mode can be in any direction. 
Ortho: After selecting this mode, only perpendicular lines may be drawn 
inside the AutoCAD view.

AutoCAD Menu Button Functions:

No. Item Function

1 This button is used to upload a background image into Actron VRF Select.

2
This button is used to export a completed file of Actron VRF Select to a selected location on 
the computer.

3
This button is used to adjust some parameters for the AutoCAD view of Actron VRF Select 
software.

4 This button is used to scale the imported image inside Actron VRF Select , AutoCAD view.

5 This button can be used to set different floors inside the AutoCAD drawing.

6 This button is used to add an indoor unit on the AutoCAD view of Actron VRF Select.

7 This button is used to start building a system inside the AutoCAD view.

8 This button is used to set an indoor unit inside the AutoCAD view drawing.

9 This button is used to draw the horizontal refrigerant piping.

10 This button can be used to draw vertical refrigerant piping.

11 This button is used to lay different kinds of connectors in the drawing.

12 This button is used to put a broken pipe symbol in the drawing.

13 This button is used to update the broken pipe sign.

14 This button is used to auto connect indoor units with refrigerant pipes.

15 This button is used to delete branch and fillet pipes.

16 This button is used to break the intersecting pipes in a drawing in AutoCAD mode.

17  This button is used to fillet two pipes in the Autocad drawing.

18 This button is used to calculate the validity of the system.

19 This button is used to calculate the condenser pipe related calculations in the system.

20 This button is used to draw the PQE wires in the drawing.

21 This button is used to copy an object in the drawing.

22 This button is used to move an object in the drawing.

23 This button is used to select an item to delete.

24 This button is used to select an area and delete the items inside the selected area.
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03.01.  AutoCAD View Small Queries
Recognizing that the AutoCAD mode selection process may pose challenges for beginners, this section delves into addressing 
common queries that users might encounter when utilising the AutoCAD mode within the Actron VRF selection software.

NOTE

See below for reference.

Right click 

Right button of the mouse

Left click

Left button of the mouse

03.01.01.  How to copy an object?
There are three ways to enter the Copy command of the software.

A. Ctrl+C

Step 1. Left click to select the object then press Ctrl+C from the keyboard. The selected object will get into the copy 
command.

Step 2. Next select the point on the on the object from where you want to hold the object to be copied. You can choose one 
of the points where a small pink box appears as shown in the picture below, a white line will show up from the holding 
point. 

Step 3. Once you reach the place where you want to paste the copied object, left click.

Then right click or Escape button on keyboard to exit the Copy command.

B. Right Mouse Click

Step 1. Left click to select the object. Then right click to show fly-out selection, left click on the copy command.

Step 2. Next select the point on the on the object from where you want to hold the object while copy. You can choose one of 
the points where a small pink box appears as shown in the picture below. A white line will show up and once you reach 
the place where you want to paste the copied object, left click.

Then right click or Escape button on keyboard to exit the Copy command.
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C. Using the copy command

Step 1. Select the object using the left click and then select the Copy command from the Top Menu of the AutoCAD view of 
the Actron VRF Select as shown below.

Step 2. Next select the point on the on the object from where you want to hold the object while copy. You can choose one of 
the points where a small pink box appears as shown in the picture below. A white line will show up and once you reach 
the place where you want to paste the copied object, left click.

Then right click or press Escape button on keyboard to exit the Copy command.

03.01.02. How to move an object
There are two ways to move an object inside the AutoCAD view of the Actron VRF Select software.

Simply Drag and Drop

1. Each of the object have some small boxes on it , to move an object simply left click on any of such boxes and then left click 
at the place where you want to move this object.

NOTE

The boxes highlighted in the yellow color show the place from which the object can be moved

2. To move the object, hold the object and left click on any of such boxes. Move the mouse to where the object is to be 
placed and left click again as is shown in the picture below.  

3. Once you left click, the object will be moved.
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03.01.03. How to use the Break Intersecting Pipe function?

This function allows making intersecting pipes to be made up into different objects, thereby making it easier to delete the 
unwanted objects inside an AutoCAD drawing.

In the current example depicted below, there are just two refrigerant pipe objects: one is the vertical refrigerant pipe, and the 
other is the horizontal refrigerant pipe. Their respective lengths are clearly indicated. If there is a need to combine these into 
a single entity.

Step 1. Click on the Break Intersecting Pipe  function in the Menu Tab. Select the region in which the items are present 
which contain the breaking pipes.  

Step 2. After selecting the pipe, press the right button to let the command work and the selected pipe would be changed into 
4 objects from the point of intersection as is shown in the picture below.

This function is particularly useful for areas where we join the refrigerant pipe to the indoor unit by manual connection As is 
shown in the picture below.

03.01.04. How to use the Setting Function?
The Setting function provides the liberty to set various parameters inside the AutoCAD function of the selection software 
Actron VRF Select.

Click on the Setting button in the AutoCAD menu tab to open the dialog box as shown below:

The function of the various tabs inside the Setting is as follows:
Background Color: This setting is to change the background color of the AutoCAD view of the Actron VRF Select selection 
software

Menu Dock: This is to adjust the Menu bar of the AutoCAD view to different locations on the screen, Left, Right or Center.
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Refrigerant Pipe Width: This function is used to increase the thickness of the refrigerant pipe shown on the Selection 
interface.

Condensation Pipe Width: This function is used to set the thickness for the Water Pipe or the Drain Pipe of the system.

Hide Background: This is to hide the Background image inside the software.

03.01.05. How to insert an image inside the Software and scale the image?
AutoCAD view of the selection software Actron VRF Select gives the liberty to add a background image into the software. The 
user can add a jpg, bmp or dwg file into the software. To add an image inside the selection software Actron VRF Select, go on 
the Insert an image option of the Actron VRF Select.

Once you select the file to be uploaded , the following dialog box would open.

The software will prompt the user to adjust the scale of the file. The scale may also be adjusted later on in the Scale tab of the 
selection software.

Here you can set the real dimensions of the drawing. For example, the dimension as highlighted in the image is 1100 for the 
real drawing whereas the software picks it up as 25.46. So, in the real length we can change the length to original that is 1100.

Once you have selected the image inside the software and done the scaling, the rest of the selection can be done , in the same 
way as mentioned in Section 04.03.

In the Setting Tab, you can click Hide background to do the selection without letting the background image to appear as 
shown in the picture below:
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03.01.06. How to set different floors and use Broken Pipe Symbol
This feature is especially useful for visualizing indoor and outdoor units located on different floors. As the AutoCAD view in 
the selection software is limited to a 2D perspective, displaying indoor and outdoor units on distinct floors can be achieved by 
initially configuring the drawing to represent the various floors depicted in the unit’s layout map.

Select the Lay broken pipe sign to set the outflow and inflow respectively.

Outflow and Inflow
Outflow is selected on the outdoor unit side branch joint. It implies that a vertical pipe has been laid down from that point to 
the lower floor. Whereas the lower floor in such a case must be using the inflow to signify the point where the outflow from 
the outdoor unit side meets the inflow from the indoor unit side. The Outflow and Inflow functions always work in pair. Every 
outflow must have an inflow.

1. You can firstly select the Outflow on the outdoor unit side to set the outflow.

2. Select the floor from which this outflow comes down. The software will calculate extra piping length between the 
corresponding outflow and inflow equal to the height difference between the floors. 

In this example, we are setting the Floor #1 and Floor #2 difference as 3 m and outdoor unit as Outflow on Floor 2 and indoor 
unit as Inflow on Floor 1 as per the table below.

Selection Location Floor Name

Outflow Outdoor Unit Floor 2

Inflow Indoor Unit Floor 1

Once you select the corresponding outflow at place, you must also keep the corresponding inflow at its required place, as 
shown in the picture below.
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Click on the Outflow and Inflow to adjust the height and the floor on which these outflow and inflow are present actually.

In this example, we are setting the outflow on Floor 2 and the inflow on Floor 1, so as to imply that the outdoor unit is on floor 
2 and the indoor unit is on floor 1.

Once finished , the software will show on clicking that which outflow and inflow are connected with each other.

This way we can represent different floors inside the same AutoCAD drawing.

03.01.07. How to fillet two pipes?
The Fillet function is used to connect to end pipes together.

Step 1. Select the Fillet two pipes function of the Selection software Actron VRF Select. Left click to select the two pipes to be 
joined together one by one.
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Step 2. Then, right click to execute the command as is shown in the picture below. The two pipes would be joined together.

03.01.08. How to connect Indoor unit to the Refrigerant piping?
There are three ways to do this part. We will discuss all the parts one by one.

A. Auto Connect:

Auto connect function can be used to automatically connect the indoor units with the main pipe of the system. The various 
steps to do this are as follows:

First click on the Auto Connect button in the AutoCAD menu section.

Select the indoor unit /units or pipe which you want to Auto connect using the selection interface.

NOTE

Please input branch direct point (Entry end point).

The software will ask to put the branch joint direction, once you select the required indoor units and the main pipe.

Once you put the branch joint direction, the indoor units and the main pipe would be connected automatically as shown in 
the picture below.
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B. Lay Connector

In this section, we can lay a branch joint by ourselves or we can also connect a pipe with an indoor unit one by one.

Lay

Put the required connector according to the requirement and position as shown in the pictures.

Once you lay the connector at its required place, draw the remaining pipes using the pipe drawing function of the software, as 
shown in the pictures.

Joint:
First, draw the required lengths of pipes from the indoor units to the main pipe, leaving just enough space for the Branch joint 
to be held and then click on lay connector and select joint.

This is another method of joining the indoor unit with the main pipe. To use this method, go to Lay connector tab and click on 
Joint.
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The software will give a command to select the two pipes between which you want to insert the joint. Select the two pipes and 
use right click to confirm.

NOTE

Select two refrigerant intersection pipes.

 

Click on the pipes that you want to join together and right click to put the joint in place as is shown in the picture below.

NOTE

Please input branch direct point (Entry end point).

You can use any of the above methods to place the indoor units and connect various branch joints with the main pipe of the 
system. Once you have selected the indoor units, select the outdoor unit for the system.
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03.01.09. How to connect Outdoor unit with the Refrigerant piping?
Once you have selected the Outdoor Unit and placed it at the required position, connect the Outdoor Unit to the Indoor Unit 
side. To connect the Outdoor Unit to the system, there are three ways:

A. Auto connect

To connect the Outdoor Unit automatically with the Indoor Unit network

NOTE

Please select pipe (Only support 2 vertexes) and equipments to auto connect.

Select the pipe from the outdoor unit side and indoor unit side and apply right click.

Next put the direction of the branch joint and right click.

B. Simply connect the outdoor unit pipe with the indoor unit pipe

Second way is to simply draw the piping between the indoor unit side and the outdoor unit and join it as is show in the pictures 
below.
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The pipes can be joint easily using this method.

C. Outflow and Inflow

This feature is especially useful for visualizing indoor and outdoor units located on different floors. As the AutoCAD view in 
the selection software is limited to a 2D perspective, displaying indoor and outdoor units on distinct floors can be achieved by 
initially configuring the drawing to represent the various floors depicted in the unit’s layout map.

For complete details on Outflow and Inflow, please refer to Subsection 03.01.06. How to set different floors and use Broken 
Pipe Symbol.

03.01.10. 3.1.10 How to delete an object in the AutoCAD view of the Actron VRF Select?
To delete an object in the Actron VRF Select, click on the delete command on the AutoCAD software menu.

 Select item to delete: From this function, we may specifically delete a particular item from the selection software 
interface.

 Delete Selected: This function is used to delete the selected items from the AutoCAD drawing.

Step 1. Select the command.

Step 2.  Select the items to delete.

Step 3. Right click to execute the command and delete the selected objects.

The selected objects would be deleted from the interface.
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03.01.11. How to show the PQE wires inside the Actron VRF Select AutoCAD view?
The AutoCAD view of the Actron VRF Select selection software gives the option to mark the PQE wires on the AutoCAD 
selection platform. The various methods to use this function are as follows:

Step 1. Select the command to show the PQE wires.

Step 2. Click on the Outdoor Unit of the system for which we need to draw PQE wires.

Step 3. Right click to execute the command.

The PQE wires for the whole system would be drawn.

03.01.12. How to select an Individual Controller for each Indoor Unit?
Selecting an individual controller can be done in the same way in the AutoCAD mode as well as the Drag and Drop Mode of 
the selection software as discussed below.

Drag and Drop Mode
To select a controller in drag and drop mode, right click on the indoor unit and select the Individual Control from the menu. 
From the menu that opens up next, select the required Individual Controller for that particular indoor unit.

Once the selection is complete the individual controller would be shown on the interface.
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AutoCAD View 03.01.13. How to select a Group Controller?
Similar to the individual controller, the Group Controller can be selected in similar fashion in both Drag and Drop and 
AutoCAD views.

Drag and Drop View:
Left click and select the indoor units that you want to add under one group control.

Right click on any of the selected indoor unit and in the menu that appears next select the Group Controller. The Group 
Controller more allows you to select more than one Group Controller to the same Group.
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The Group Controller has been added in the system as shown below.

04. HOW TO ADD A SYSTEM INTO ACTRON VRF SELECT
In this section, we will have a look on how to make a new system inside the Actron VRF Select software. You can follow these 
simple steps to make a selection inside the Actron VRF Select Drag and Drop mode. 

04.01. Drag and Drop Mode
In this section, we will learn how to add a system into the Actron VRF Select in Drag and Drop View. First of all choose the Drag/
Drop View on the software startup screen to enter the Drag/Drop View of the Actron VRF Select selection software.

Before starting to select a system, adjust the settings in Project Tab > Project Properties and Unit Set as discussed in Subsection 
01.03. Basic Settings.

Step 1.    Click on the add System Tab in the Systems Tab > Home Tab > Add System. Here select the type of system that want to 
start.

Step 2.    Drag and drop the piping joints to build the piping diagram and the indoor units to the indoor unit ports.
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Step 3.    When you put the Indoor Unit to the Indoor Unit port, the following dialog box would open according to the selected 
Indoor Unit type. (Below shown example is for Four-Way Cassette). 

NOTES

• Below shown example is for Four-Way Cassette

10

No. Item Description

1 Room name To add a name to a room in Actron VRF Select

2 IDU Name To add a name to the Indoor Unit in Actron VRF Select

3 Type of the IDU To select the type of Indoor Unit

4 IDUs This part shows the list of the Indoor Unit models of selected Indoor Unit type in 3.

5 Safety Factor

6 Fan Speed
To select the default Indoor Unit fan speed at which the selection of Indoor Unit is 
being carried out.

7 Auto Select
Click this button for the software to auto select the Indoor Unit on the basis of 
information in 8.

8 Required Capacity Fill in the required capacity for the Indoor Unit.

9 IDU address Address for the Indoor Unit

10 Override Project Conditions
Check this to select the Indoor Unit at different design conditions than mentioned in 
Project Conditions.
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Sr. No. Description

1 Here you can select the number of controllers

2 Here you can select the type of the controller

Step 4.    After selecting the Indoor Units; remote controller double left click on the space for Outdoor Unit.

The dialog box would appear.

No. Item Description

1 System name Here you can edit the name of the system.

2 ODU Here you can manually select the Outdoor Unit.

3 Override project condition If we check this, we can override the design conditions set in Project Properties.

4 Auto Select
Click this button for the software to auto select the Indoor Unit on the basis of 
Indoor Unit.

5 Connection Ratio This is to set the connection ratio value for the system.

6 Height To select the parameters related to height of the current VRF system.
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Adding a Group Control: Right click and select a number of Indoor Units to add them together in a group control as shown in 
the picture below:

Step 5.    After you finish adding Indoor Units and Outdoor Units to the system; click on Calculate tab.

If all the parameters selected are according to the allowed range, the calculations will be finished and shown in the Output 
View Tab and the piping diameters will begin to reflect as shown in the picture. If it is so, the calculations have been successful.

In the same way, we can add more systems into the Actron VRF Select and all the created systems will appear in the Project 
View tab. You can also copy and paste a system.
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04.02. AutoCAD Mode
In this section, we will discuss how to add a system in the AutoCAD View of the selection software. First of all, select the
AutoCAD view on the software startup screen to enter the AutoCAD view of the Actron VRF Select selection software, as shown 
in the picture below.

Before starting to select a system, adjust the settings in Project Tab > Project Properties and Unit Set as discussed in subsection 
01.03. Basic Settings.

Step 1.    Adding various indoor units at the respective locations 

Select the Add Indoor unit tab on the Menu button interface of the AutoCAD view of the Actron VRF. Select to add indoor units 
inside the selection area.

The following dialog box will open up.

10

Sr. No. Item Description

1 Room Name To add a name to a room in Actron VRF Select

2 IDU Name To add a name to the Indoor Unit in Actron VRF Select

3 Type of the IDU To select the type of Indoor Unit

4 Indoor Units This part shows the list of the Indoor Unit models of selected Indoor Unit type in 3.

5 Safety Factor Safety factor for cooling load calculations

6 Fan Speed
To select the default Indoor Unit fan speed at which the selection of Indoor Unit is 
being carried out.

7 Auto select
Click this button for the software to auto select the Indoor Unit on the basis of 
information in 8. You can Auto Select (Select by Cooling) or (Select by Heating) 
according to the requirements of the real selection.

8 Required Capacity Fill in the required capacity for the Indoor Unit

9

IDU address Here you can set the address for the Indoor Unit.

Height Here you can set the height for the Indoor Unit.

Angle Here you can set the angle for the Indoor Unit.

10 Override Project Conditions
Check this to select the Indoor Unit at different design conditions than mentioned in 
Project Conditions.
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Sr. No. Description

1
Here you can select the number of 
controllers

2
Here you can select the type of the 
controller

Using the mouse you can move the indoor unit at a specified position in the drawing area. The indoor unit color would turn to 
pink once you have successfully put the indoor unit.

Left click to put the indoor unit as per your desired location. Arrange all the indoor units according to the requirements of the 
drawing. The steps are similar, you can copy an indoor unit or you can keep on adding a new indoor unit each time.

Here we have made a very symmetrical and simple system for the better understanding of the reader.

Step 2.    Draw the Refrigerant Main pipe

Use the refrigerant pipe drawing function to lay the main pipe for the refrigerant system being selected.

NOTE

Please input first point.

The Output view will ask you to put the first point of the refrigerant pipe. Left click to specify the first point.

NOTE

Please input second point.

Similarly left click to specify the second point or end point of the refrigerant pipe.

To draw a pipe just simply select the beginning and end point of the pipe and right click to confirm as shown in the picture above.

Step 3.    Connect the main pipe with the indoor unit

For this step, refer to Subsection 03.01.08 How to connect indoor unit to refrigerant piping.
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Step 4.    Build a system and select the outdoor unit

Once you have placed the indoor units at their required places in the drawing, it is time to select the outdoor unit for the system 
as well as building a system. To build a system, that is to define various indoor units to be part of different systems, select the 
Assign IDUs to System button.

Once you click on this button, the following dialogs box would open. Click on Add system to add a system type in the project 
and select the type of the system that you want to use.

Next, click on Select IDUs button to select the indoor units which are to be added into the system type selected in the previous 
step.

Click on Select IDUs button and select the IDUs which you want to be the part of the same system and then right click to confirm 
the selection.

Then, click on Layout ODU button to select the ODU for this system. 
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The dialog box would open up as shown below.

No. Item Description

1 System name Here you can edit the name of the system.

2 ODU Here you can manually select the Outdoor Unit.

3 Override project condition If we check this, we can override the design conditions set in Project Properties.

4 Auto Select
Click this button for the software to auto select the Indoor Unit on the basis of 
Indoor Unit information.

5 Connection Ratio This is to set the connection ratio value for the system.

6 Height To select the parameters related to height of the current VRF system.

You can select the ODU as per your requirement or simply click on Auto Select button to let the software to select the ODU for 
your selection.

Once the ODU has been selected, you can place the outdoor unit at the required place in the drawing.

Step 5.    Connecting ODU to the IDU side

Once you have selected the outdoor unit and placed it at the required position, connect the ODU to the IDU side. To connect 
the ODU to the system, refer to Subsection 03.01.09 How to connect outdoor unit with the refrigerant piping.

Step 6.    Calculate whether the system is okay or not 

Click on Calculate button to see the output of the system, refer to the Output view to see if all the calculations of the system are 
correct.

The piping diameters will begin to show if all the calculations are correct and also will be written in the Output View of the 
software.
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In case the system has any error, it will have a cross sign at the respective location and the corresponding message would be 
shown in the Output view of the software as well.

There will be a cross on the indoor unit if the connection is not correct. You must find the reason for the wrong connection and 
click on Calculate again until all the calculations are correct and the piping diameters will begin to show up on the drawing.

Once all the calculations are correct and the diagrams begin to show up, the system has been finished.

Step 7.    Drawing the PQE wires 

Once you will click on this button, it will ask you to select the ODU and the PQE wires connecting that outdoor unit and indoor 
will begin to show.

Step 8.    Selecting the Individual Controller

To select an indoor unit, select the indoor unit firstly and then right click on the indoor unit, to select the controller as shown in 
the picture below.

Similarly you can select any other controller of your choice from the list shown above.
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Step 9.    Selecting a Group Controller 

To select a group controller together for more than one indoor unit, right click and select the indoor units for which we need to 
select the group controller.

Then right click to select a specific controller for these indoor units.

Click on Group Control More to select more than one Group Controller for the selected indoor units. After doing this , you can 
switch the Tab to Controls View to select the Centralised controller. The method to select the centralized controller is same no 
matter you select the system in Drag and Drop View or the AutoCAD View.

Step 10.    Exporting the finished AutoCAD file 

Click on Export to a DWG drawing button to export the finished AutoCAD selection file in dwg format on any disk on your 
computer.

04.03. How to add a centralised controller group into Actron VRF Select
Once you have finished adding the required number of systems into the Actron VRF Select; we can add the centralized controller 
group also. The following are the steps that need to be followed while adding a centralized controller group into the ongoing 
project. The centralized controller can only be added in the Controls View in the Switch View Section of the Software only.

Step 1.    Go to Switch View tab and left click on the Controls View button. 

Step 2.    Right click on the Centralized Control View tab and select the New Centralized Group.

Step 3.    Select the required system in the dialog box as show below.
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Step 4.    From the Layout Units view, drag and drop the required centralized controller in the controller empty dialog box.

Step 5.    Double left click on the controller to adjust the number of ports used of the controller as well as the IP of the computer 
as shown in the picture below:

Step 6.    After selecting the centralized controller’s ports and IP, right click on the space for the system to select the systems 
which are going to be monitored by this centralized controller.

Select the number of systems from the dialog box that show the total systems available in the current selection. 



  73  72 ACTRON VRF SELECT Manual
Doc. No. 9590-5028-10  Ver. 1  231112

ACTRON VRF SELECT Manual ECOFLEX MINI VRF R-32 SERIES

ACTRON VRF SELECT Manual
Doc. No. 9590-5028-10  Ver. 1  231112

ACTRON VRF SELECT Manual ECOFLEX MINI VRF R-32 SERIES

After selecting the number of systems, the centralized controller selection would be complete.

Once the centralized controllers are also selected, you can go to the Export tab to export the Material List and Electrical 
characteristics in MS Excel format whereas the Report which contains the complete details about the software can be exported 
in the PDF and Excel format both which contains the complete detailed information regarding the requirements of this project.

04.04. Finishing the Selection and exporting the Technical documents
Once you have finished selecting the centralised controllers for the system, click on the Export tab to export the related 
documents out of the system and save the required files to your preferred location. The reports contain the complete details 
about the equipment list, pipe sizes , electrical characteristics and other important details about the system.

No. Item Description

1
Exports the list of materials required to complete the project. It provides the list of 
Equipment as well as the list of materials that we need to arrange on the field.

2
This gives a list of the electrical parameters for the VRF outdoor units being used in 
the project.

3
This is used to export a complete detailed list for the Project requirements. We have 
two options; we can export the Report in PDF as well as the Excel format.

4
This button is used to export the piping diagrams and centralized controllers 
diagram in AutoCAD format to a location on the computer.

5 Reserved Button
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